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Foreword
Thank you for purchasing the Daqstation DX1000/DX1000N (DX).

This manual describes the basic functions and operating

procedures of the DX1000/DX1000N.  To ensure correct use,

please read this manual thoroughly before operation.  The following

four manuals are provided as DX1000/DX1000N manuals.

Paper Manual

Manual Title Manual No.

DX1000/DX1000N Operation Guide IM 04L41B01-02E

This manual.  It is also provided in the CD.

Electronic Manuals Provided on the Accompanying CD

Manual Title Manual No.

DX1000/DX1000N Operation Guide IM 04L41B01-02E

This is the electronic version of the paper manual.

DX1000/DX1000N User’s Manual IM 04L41B01-01E

Describes how to use the convenient functions of the DX1000.

Communication function is excluded.

DX1000/DX1000N/DX2000 IM 04L41B01-17E

Communication Interface User’s Manual

Describes how to use the communication functions using the

Ethernet and serial interfaces.

DAQSTANDARD User’s Manual IM 04L41B01-61E

Describes how to use the accompanying software program,

DAQSTANDARD.

Notes
• The contents of this manual are subject to change without prior

notice as a result of continuing improvements to the instrument’s

performance and functions.

• Every effort has been made in the preparation of this manual to

ensure the accuracy of its contents.  However, should you have

any questions or find any errors, please contact your nearest

YOKOGAWA dealer.

• Copying or reproducing all or any part of the contents of this

manual without YOKOGAWA’s permission is strictly prohibited.

• The TCP/IP software of this product and the document

concerning the TCP/IP software have been developed/created

by YOKOGAWA based on the BSD Networking Software,

Release 1 that has been licensed from the Regents of the

University of California.

Trademarks
• All the brands or names of Yokogawa Electric’s products used in

this manual are either trademarks or registered trademarks of

Yokogawa Electric Corporation.

• Microsoft, MS-DOS, Windows, Windows NT, and Windows XP

are either registered trademarks or trademarks of Microsoft

Corporation in the United States and/or other countries.

• Adobe, Acrobat, and PostScript are trademarks of Adobe

Systems Incorporated (Adobe Systems).

• CompactFlash and CF are trademarks of SanDisk Corporation.

• For purposes of this manual, the TM and ® symbols do not

accompany their respective trademark names or registered

trademark names.

• Company and product names that appear in this manual are

trademarks or registered trademarks of their respective holders.

Revisions
1st Edition: December 2005

Safety Precautions
The DX conforms to IEC safety class I (provided with terminal for

protective grounding), Installation Category II, and EN61326-1

(EMC standard), class A (use in a commercial, industrial, or

business environment).

The DX is a measurement category II (CAT II) instrument.

* Measurement category II (CAT II)

Applies to measuring circuits connected to low voltage

installation, and electrical instruments supplied with power from

fixed equipment such as electric switchboards.

The general safety precautions described here must be observed

during all phases of operation.  If the DX is used in a manner not

described in this manual, the protection provided by the DX may be

impaired.  Yokogawa Electric Corporation assumes no liability for

the customer’s failure to comply with these requirements.

Use the DX as a measurement category II (CAT II) instrument.

The DX is designed for indoor use.

• About This Manual
• Please pass this manual to the end user.  We also ask you to

store this manual in a safe place.
• Read this manual thoroughly and have a clear understanding of

the product before operation.
• This manual explains the functions of the product.  It does not

guarantee that the product will suit a particular purpose of the user.

• Precautions Related to the Protection, Safety, and Alteration

of the Product

The following safety symbols are used on the product and in this

manual.

“Handle with care.”  To avoid injury and damage to 
the instrument, the operator must refer to the 
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal 
as a protective ground terminal.)

Alternating current

ON (power)

OFF (power)

• For the protection and safe use of the product and the system in

which this product is incorporated, be sure to follow the instructions

and precautions on safety that are stated in this manual whenever

you handle the product.  Take special note that if you handle the

product in a manner that violates these instructions, the protection

functionality of the product may be damaged or impaired.  In such

cases, YOKOGAWA does not guarantee the quality, performance,

function, and safety of product.

• When installing protection and/or safety circuits such as lightning

protection devices and equipment for the product and control system

or designing or installing separate protection and/or safety circuits for

fool-proof design and fail-safe design of the processes and lines that

use the product and the control system, the user should implement

these using additional devices and equipment.

• If you are replacing parts or consumable items of the product,

make sure to use parts specified by YOKOGAWA.

• This product is not designed or manufactured to be used in

critical applications that directly affect or threaten human lives.

Such applications include nuclear power equipment, devices

using radioactivity, railway facilities, aviation equipment, air

navigation facilities, aviation facilities, and medical equipment.  If

so used, it is the user’s responsibility to include in the system

additional equipment and devices that ensure personnel safety.

• Do not modify this product.

1st Edition: December 2005 (YK)

All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation
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WARNING

• Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power

supply before turning ON the power.  In the case of a desktop
type, ensure that it is within the maximum rated voltage range of

the provided power cord before connecting the power cord.

• Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord

supplied by YOKOGAWA.  The main power plug must be

plugged into an outlet with a protective earth terminal.  Do not

disable this protection by using an extension cord without

protective earth grounding.

• Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent

electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-

prong type power cord.  Connect the power cord to a properly

grounded three-prong outlet.

• Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or

disconnect the wiring of the protective grounding terminal.

Doing so invalidates the protective functions of the instrument

and poses a potential shock hazard.

• Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might

be defective.  Also, make sure to check them before operation.

• Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable

liquids or vapors.  Operation in such an environment constitutes

a safety hazard.

Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.)

will cause a malfunction.

• Do Not Remove Covers

The cover should be removed by YOKOGAWA’s qualified

personnel only.  Opening the cover is dangerous, because

some areas inside the instrument have high voltages.

• Ground the Instrument before Making External Connections

Connect the protective grounding before connecting to the item

under measurement or control unit.

• Damage to the Protection

Operating the instrument in a manner not described in this

manual may damage the instrument’s protection.

• Exemption from Responsibility

• YOKOGAWA makes no warranties regarding the product except

those stated in the WARRANTY that is provided separately.

• YOKOGAWA assumes no liability to any party for any loss or

damage, direct or indirect, caused by the user or any

unpredictable defect of the product.

• Handling Precautions of the Software

• YOKOGAWA makes no warranties regarding the software

accompanying this product except those stated in the

WARRANTY that is provided separately.

• Use the software on a single PC.

• You must purchase another copy of the software, if you are to

use the software on another PC.

• Copying the software for any purposes other than backup is

strictly prohibited.

• Please store the original media containing the software in a safe

place.

• Reverse engineering, such as decompiling of the software, is

strictly prohibited.

• No portion of the software supplied by YOKOGAWA may be

transferred, exchanged, or sublet or leased for use by any third

party without prior permission by YOKOGAWA.

Handling Precautions of the DX
• Use care when cleaning the DX, especially any plastic parts.

When cleaning, wipe using a dry soft cloth.  Do not use

chemicals such as benzene or thinner, since these may cause

discoloring and deformation.

• Keep electrically charged objects away from the signal

terminals.  If you do, the DX may malfunction.

• Do not apply volatile chemicals to the display, panel keys, etc.

Do not allow rubber and vinyl products to remain in contact with

the DX for long periods of time.  If you do, the DX may

malfunction.

• When not in use, make sure to turn OFF the power switch.

• If there are any symptoms of trouble such as strange odors or

smoke coming from the DX, immediately turn OFF the power

switch and the power supply source.  Then, contact your

nearest YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

• Use caution in the handling of the external storage medium as it

is a delicate product.

• Write operation to storage media may fail under high-

temperature or low-temperature environments.  If you are using

the DX in a low-temperature environment (around 10 °C or

less), use the DX after the warm-up time (at least 30 minutes)

has elapsed.  If you are using the DX under a high-temperature

environment (around 40 °C or more), it is recommended that the

external storage medium be inserted into the drive when saving

the data and be removed after the data storage operation is

finished.

• Remove the storage medium from the drive when turning the

DX ON/OFF.

• Touching the compact flash section when static electricity is built

up on the human body can lead to erroneous operation.

• For the general handling precautions of the external storage

medium, see the instruction manual that came with the external

storage medium.

CAUTION

• Do not eject the external storage medium while the access

indicator is illuminated.  This can damage the data.

• Do not access the storage medium in a place with vibrations or

shock.  The storage medium or drive may malfunction.
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Checking the Contents of the Package
Unpack the box and check the contents before operating the

instrument.  If some of the contents are not correct or missing or if

there is physical damage, contact the dealer from which you

purchased them.

DX

A name plate is located on the top panel of the DX (side panel on

models with the /H5[ ] option).  Check that the model name and

suffix code given on the name plate on the rear panel match those

on your order.

name plate

DISP/ENTER

6

9

7

8

10

11

12

1

2

3

4 5

100-240V AC

50/60Hz 100VA MAX
N

L

MODEL

FREQUENCY

NO.

SUFFIX

SUPPLY

STYLE
H S

Made in China

C US
172608

N200

R

NO. (Instrument Number)

When contacting the dealer from which you purchased the

instrument, please give them the instrument number.

MODEL and SUFFIX Code

Model code Suffix code

 -1
 -2

 -4
 -2

Daqstation DX1000 2ch, 125ms (25ms*12)
Daqstation DX1000 4ch, 125ms (25ms*12)
Daqstation DX1000 6ch, 1s (125ms*12)
Daqstation DX1000 12ch, 1s (125ms*12)
Daqstation DX1000N 2ch, 125ms (25ms*12)
Daqstation DX1000N 4ch, 125ms (25ms*12)
Daqstation DX1000N 6ch, 1s (125ms*12)
Daqstation DX1000N 12ch, 1s (125ms*12)
Standard Memory
Large Memory
CF card (with medium)
English, degF, DST (summer/winter time)

DX1002
DX1004
DX1006
DX1012
DX1002N*11

DX1004N*11

DX1006N*11

DX1012N*11

Internal memory

External storage medium
Language
Options /A1 Alarm output 2 points*1

/A2 Alarm output 4 points*1

/A3 Alarm output 6 points*1*2

/C2 RS-232 interface*3

/C3 RS-422A/485 interface*3

/F1 FAIL/Status output*2

/H2 Clamped input terminal (detachable)
/H5[ ] Desktop type*4

/M1 Mathmatical functions
/N1 Cu10, Cu25 RTD input/3 leg isolated RTD
/N2 3 leg isolated RTD*5

/N3 Extended input type (PR40-20, JPt50, etc.)
/R1 Remote control
/TPS2 24VDC transmitter power supply (2 loops)*6

/TPS4 24VDC transmitter power supply (4 loops)*7

/KB1 Easy text entry (with input terminal)*8*9

/KB2 Easy text entry (without input terminal)*8

/USB1 USB interface
/PM1 Pulse input (including remote control and mathmatical functions)*10

/CC1 Calibration correction function

Optional
code Description

*1 /A1, /A2, /A3 cannot be specified together.
*2 /A3 and /F1 cannot be specified together.
*3 /C2 and /C3 cannot be specified together.
*4 /H5[  ] can be specified for only DX1002, DX1004, DX1006, and DX1012.
  D: Power cord UL, CSA st’d
  F: Power cord VDE st’d
  R: Power cord SAA st’d
  J: Power cord BS st’d
  H: Power cord GB st’d
*5 /N2 can be specified for only DX1006, DX1006N, DX1012, and DX1012N.
*6 In case that /TPS2 is specified, /TPS4, /A2, /A3, or /F1 cannot be specified 

together.
*7 In case that /TPS4 is specified, /TPS2, /A1, /A2, /A3, or /F1 cannot be 

specified together.
*8 /KB1 and /KB2 cannot be specified together.
*9 In case that /KB1 is specified, remote input terminal (438227) is included.
*10 In case that /PM1 is specified, /A3, /M1, /R1, /TPS2, or /TPS4 cannot be 

specified.  And combination of /A2, /F1 cannot be specified together.
*11 DX1002N, DX1004N, DX1006N, and DX1012N are Pull Out Models.
*12 Values in parentheses are for the fast sampling mode.

Standard Accessories

The standard accessories below are supplied with the instrument.

Check that all contents are present and undamaged.

9

ID No.

1 2 43

6 75

32MB

8. One of these power cord types is supplied according 
to the instrument’s suffix code

/H5F/H5D /H5R

/H5H/H5J

No.Name Number/Model Qty. Notes

1 Terminal screws E9655FX 5 spares  M4

2 Mounting brackets B9900BX 2 For panel mounting

Except for the /H5[ ]

models.

3 Door lock key B8706FX 2 –

4 DAQSTANDARD DXA120 1 CD.  Software for

for DXAdvanced setting the DX and

 displaying data.

5 DX1000/DX1000N IM 04L41B01-02E 1 A4 size

Operation Guide

(this manual)

6 Manuals for the B8706ZZ 1 CD.  Contains the PDF

DX1000/DX1000N/ file of the user’s

DX2000 manual.

7 CF card B9968NM 1 32 MB (The size and

model may change.)

8 Power cord A1006WD 1 Supplied only for

models with the /H5D

option.  Maximum rated

voltage: 125 V

A1009WD 1 Supplied only for

models with the /H5F

option.  Maximum rated

voltage: 250 V

A1024WD 1 Supplied only for

models with the /H5R

option.  Maximum rated

voltage: 250 V
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No.Name Number/Model Qty. Notes

A1054WD 1 Supplied only for

models with the /H5J

option.  Maximum rated

voltage: 250 V

A1064WD 1 Supplied only for

models with the /H5H

option.  Maximum rated

voltage: 250 V

9 Remote control 438227 1 Remote controller.

terminal Supplied only for

models with the /KB1

option.  With two AA

alkaline batteries and

labels for the remote

control terminal.

Optional Accessories (Sold Separately)

The following optional accessories are available for purchase

separately.  If you make an order, make sure that all contents are

present and undamaged.  For information about ordering

accessories, contact the dealer from which you purchased the DX.

No.Name Model Minimum Notes

Q’ty

1 CF card 772091 1 128 MB

772092 1 256 MB

772093 1 512 MB

772094 1 1 GB

2 CF card adapter 772090 1 –

3 Shunt resistor 415920 1 250 Ω ± 0.1%
(for screw input terminal) 415921 1 100 Ω ± 0.1%

415922 1 10 Ω ± 0.1%

4 Shunt resistor 438920 1 250 Ω ± 0.1%
(for clamped input terminal) 438921 1 100 Ω ± 0.1%

438922 1 10 Ω ± 0.1%

5 Mounting brackets B9900BX 2 –

6 Door lock key B8706FX 1 –

7 Remote control terminal 438227 1 Remote

controller.

Conventions Used in This Manual
• This manual covers information regarding DX1000/DX1000Ns

that have a suffix code for language “-2” (English).

• For details on how to set the language, see section 2.6, “Changing

the Language” in the DX1000/DX1000N User’s Manual (IM

04L41B01-01E).

Unit

K: Denotes 1024.  Example: 768 KB (file size)

k: Denotes 1000.

The following markings are used in this manual.

Improper handling or use can lead to injury to the user or damage to

the instrument.  This symbol appears on the instrument to indicate

that the user must refer to the user’s manual for special instructions.

The same symbol appears in the corresponding place in the user’s

manual to identify those instructions.  In the manual, the symbol is

used in conjunction with the word “WARNING” or “CAUTION.”

WARNING

Calls attention to actions or conditions that could cause serious or

fatal injury to the user, and precautions that can be taken to

prevent such occurrences.

CAUTION

Calls attentions to actions or conditions that could cause light injury

to the user or damage to the instrument or user’s data, and

precautions that can be taken to prevent such occurrences.

Note

Calls attention to information that is important for proper operation

of the instrument.

Indicates after this mark reference to related procedure or explanation.

Bold characters

Indicates character strings that appear on the screen and the

operation keys.

Opening the Electronic Manuals
The accompanying CD contains PDF files of the manuals.  When

you load the CD into the CD-ROM drive on your PC, a startup

screen appears.  Click the manual title to open the respective

manual.

If the startup screen does not appear, double-click DX_manual in

My Computer, and open the manuals in the English directory.
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Introduction to Functions

Measured Items
You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure various

values such as temperature and flow rate.  The DX samples the input signals at the scan
interval to obtain the measured values.  The fastest scan interval is 25 ms on the DX1002,
DX1002N, DX1004, and DX1004N and 125 ms on the DX1006, DX1006N, DX1012, and

DX1012N.
Up to four alarm conditions can be set for each measurement channel.

Data Storage Function
There are two methods of recording measured data.  One is to record the measured data
continuously, and the other is to record only when certain events occur such as alarms.

The measured data is recorded to the internal memory at a specified interval.  The data
in the internal memory can be stored to a CF card automatically or manually.  By
connecting to a network via the Ethernet interface, the measured data can also be

automatically transferred to an FTP server on a network.

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal memory

Display Function
Measured data can be displayed as trends, numeric values, and bar graphs for each
group.  In addition, the overview display can be used to display and monitor all channels
on a single screen.

Trend display Numeric (digital) display Overview displayBar graph display

Other Functions
Computation Function (option) Various types of computation can be performed by

assigning equations to computation channels.

FAIL/status output function (option) Outputs an alarm when the DX fails.  The function also
monitors the DX status such as the remaining amount of
internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the DX.  The
function can also be used to prohibit key operation.

Communication function The Ethernet interface can be used to monitor the DX
using a Web browser and transmit e-mail when an event
occurs such as an alarm.  In addition, data of devices on
the network can be loaded and displayed using the
Modbus protocol.

DAQSTANDARD
The accompanying software program, DAQSTANDARD, can be used to display the
measured data, convert the measured data format, and create DX setup data.
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DX System Configuration
The DX can be used to configure a system as shown below.

Referenced sections are of the DX1000/DX1000N User’s Manual.
Referenced pages are of this manual.

* : Option

Ethernet
(Communication Interface User's Manual)

USB port*

Alarm output*
Sec 3.5-3.8

Serial communication*
(Communication Interface 
User's Manual)

Transmitter power supply*
Page 54

PC

PC

DX

RecorderTemperature 
controller

FAIL/status output*
Sec. 2.9

USB flash memory
 Sec. 2.12

Keyboard
 Sec. 2.11

Signal input
Sec. 3.3

Pulse input*
Sec. 3.10

Remote input*
 Sec. 7.1

Remote Terminal*
 Sec. 2.10

CF card
 Page 22

Keys

Terminology
• Memory sample

The operation of recording measured data.

• Memory start
The operation of starting the memory sample.

• Memory stop
The operation of stopping the memory sample.

• Display data
The waveform data shown on the DX display.  The data recorded at the sampling

interval for the displayed data.
• Event data

Measured data recorded at a sampling interval separate from that of the display data.

Introduction to Functions
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Names of Parts

Front View

USB CF  CARD

NO.Do not remove the cover.
Repair by trained personnel only.

START USER FUNC ESC MENUSTOP

Key panel opened

Front cover opened

LCD
Display various operation 
displays such as the trend 
display as well as setup 
displays.

Power indicator
Illuminates in red when the 
power is turned ON. Illuminates 
in green when recording to the 
memory.

Power switch
Not available on the DX1002N, 
DX1004N, DX1006N, and 
DX1012N.

USB port
A USB port conforming to Rev. 
1.1.

Remote control sensor
(/KB1 and /KB2 options)
Receives infrared light from the 
remote control terminal.

Label (front of the key panel cover)
Write arbitrary labels for your
convenience.

Front cover (key panel)
Open the front cover by pulling 
the cover while holding down 
the tab at the center of the 
upper section of the cover.

CF card slot

Lock key

CF card access indicator

CF card eject button
Used when ejecting the CF 
card.

Key panel cover
Open the cover by pinching the 
left tab and pulling forward.

Door lock key (included)
Insert the pin in the left hold to lock.
Insert the pin in the left hold to unlock.

DISP/ENTER

6

9

7

8

10

11

12

1

2

3

4 5
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Rear Panel

Ethernet port
A 10Base-T port.

USB port (/USB1 option)
A USB port conforming to Rev. 
1.1.

Optional terminals (/A[ ], /F1, 
/R1, /TPS[ ], and /PM1 options)
Connect optional input/output 
signal wires.

Power supply terminal and 
protective earth terminal.

Serial interface port
(/C3 option)
A RS-422A/485 interface 
connector.

Serial interface port
(/C2 option)
A RS-232 interface 
connector.

Input terminals (screw terminals 
or clamped terminals (/H2 option))
Connect input signal wires from the 
measured item.

Desktop Type (/H5[ ] Option)

 

Power 
connector

Handle

Feet and Stand

Functional ground 
terminal

Names of Parts
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DX1000/DX1000N Workflow

When using the DX for the first time, carry out the following procedure.

Installation

W

Pow

Environmental
Settin

Fun
Sett

Measurement

Data
Management

Install the DX.I

Page 46 and subsequent pages

Connect input/output wires to the terminals and connectors on the C

rear panel, and connect the power cord. 

Page 49 and subsequent pages

Turn the power ON.  (DX1002, DX1004, DX1006, and DX1012 Only)TT

Page 12

Set the date/time, load the CF card, and so on.SSS

Page 17 and 22

Set measurement functionsS

Page 18 and subsequent page, page 26 and subsequent pages

Start the measurement.  Perform operations such as switching theSS

screen and writing messages.  Save the measured data.s  

Page 36 and subsequent pages

Check and manage the measured data.CC

Use the accompanying software program, DAQSTANDARD, to  displayU

the measured data and convert the measured data to Excel, Lotus, andt

ASCII formats.A  

 Page 45

    DAQSTANDARD User's manual (IM 04L41B01-61E)
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Turning the Power ON/OFF (DX1002, DX1004, DX1006, and DX1012 Only)

Turning the Power ON

CAUTION
Before turning ON the power switch, check that

• The power cord/wires are connected correctly to the DX.
• The DX is connected to the correct power supply (see page 56).
If the input wires are connected in parallel with other devices, do not turn ON/OFF

the power switch of the DX or another device during operation.  This can have
adverse effects on the measured values.

1. Open the operation cover.
2. Turn ON the power switch.

After performing a self-test for a few seconds, the operation screen appears.

3. Close the operation cover.

CAUTION
• If nothing is displayed when the power switch is turned ON, turn OFF the power

switch and check the points listed above one more time.  After checking the
points, turn ON the power switch again.  If the DX still does not work, it is

probably a malfunction.  Contact your nearest YOKOGAWA dealer for repairs.
• If an error message is displayed on the screen, take measures according to the

description in chapter 10, “Troubleshooting” in the DX1000/DX1000N User’s
Manual.

• Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

Turning the Power OFF

CAUTION
Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1. Open the operation cover.
2. Turn OFF the power switch.

3. Close the operation cover.
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Basic Operation

Panel Keys and Display
Keys

START USER FUNC ESC MENUSTOP

START USER FUNC ESC MENUSTOP

LCD

Key panel

Soft keys
Selects the menu that is displayed 
at the bottom of the screen

START/STOP key
Memory start/stop ESC key

Cancels an 
operation

USER key
Executes the assigned 
operation

Favorite key
Displays the operation screen (up to eight 
screens) that are registered to the key

MENU key
Switches between the operation 
mode and setting mode

FUNC key
• Displays the soft key menu in operation mode
• Hold down this key at least 3 s in the setting mode to switch from the 
 setting mode to the basic setting mode

DISP/ENTER key and four arrow 
keys (up, down, left, and right)
Switches the operation screen. 
Selects and enters setup items.

DISP/ENTER key

Up arrow key

Right arrow key

Down arrow key

Left arrow key
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Display
Status display section
Shows the display name, date/time, data recording, alarm icon, etc.

Data display section
Shows the measured data and the functional setup 

Display on the Status Display Section
The following information is displayed in the status display section.

Memory sample status

Error in internal memory.

Displayed when any alarm is activated.
Blinks when there are alarms that are 
occurring but have not been acknowledged.

All alarms have been released after they 
have occurred, but there are alarms that 
have not been acknowledged.

The status assigned to the status output 
relay (/F1 option) is occurring.

CF card icon

Keys are locked.

E-mail transmission is enabled.

White icon: Computation in progress

Yellow icon: Computation dropout occurred

CF card is being accessed.

Waiting.

CF card error.

The green level display indicates the amount of CF card 
used.  If the remaining amount falls to 10% or less of the CF 
card capacity, the color changes to red.

If the “batch number-lot number” exceeds 20 
characters, the “date and time” position is used to 
display the “batch number-lot number.”

Memory sample icon

Memory sample 
stopped

Memory sample 
in progress

Batch name (shown alternately 
with the display name)

Name of the user logged in

Batch name (shows the display 
name and date/time alternately)

Date and time
Illuminates in yellow when the function that gradually 
corrects the time is active.

Display name or group name
For all channel display on the trend display, 
“ALL” is displayed.

Data type
DISP: Display data
EVENT: Event data

Memory sample progress
Displays the progress using a green bar graph.  The frame indicates the file save 
interval (display data) or the data length (event data).

Displays the remaining memory sample time for the left bar graph.

When using the login function

When using the batch function

Alarm icon

Status icon
(shown alternately on models with the /M1 option)

Computation icon (/M1 option)

Date and time

Name of the user logged in
When using the login and batch functions

Date and time (shown 
alternately with the display name)

(Red)

(Green)

Basic Operation
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Run Modes

Power ON

Basic setting mode

MENU key 
or ESC key

Hold the 
FUNC key for 
3 seconds

DISP/ENTER 
key

DISP/ENTER 
key ESC key

End menu > DISP/ENTER key

Setting modeOperation mode

MENU key

MENU key 
or ESC key

Mode Transition Diagram

Operation display
Setting menu 
display

Setup display

Basic setting 
menu display

Setup display

The DX has three modes.

Mode Description

Operation mode A mode for performing measurements.

Setting mode A mode in which input range, measurement method, and so on are
configured.  Settings can be changed when memory sample is in
progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and storage
format of measured data.  You cannot switch to this mode when memory
sample is in progress.

* For further details on the setting mode and basic setting mode, see page 59.

Carry out the steps given in the following pages.  It will help you to understand the DX
operation.

Basic Operation
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Entering Values and Characters
The character/number input window and DISP/ENTER key are used to set the date/time,

set the display span of the input range, set the tag, set the message string, enter the
password, etc.

DISP/ENTER key and four arrow
 keys (up, down, left, and right)

Character/number input window

Left and right arrow soft keys

Text box for entering 
the character string

Select the character 
(keypad)

Input status of the Ins soft key
Input status of the A/a/1 soft key

Cursor

When a window for entering a character string appears, enter it by performing the
following key operation.

• Left and right arrow soft keys: Moves the cursor in the text box to select the input
position.

• Keypad: Use the four arrow keys (up, down, left, and right) to move the

cursor on the keypad to select the desired character.
Ins: Switches between insert and overwrite.
Del: Deletes the character at the cursor position in the text box.

ENT: Enters the character string in the text box.
• DISP/ENTER key: Enter the character that you selected with the keypad in the text

box or execute Ins, Del, or ENT.

• Bs soft key: Backspace.  Deletes the character before the cursor.
• A/a/1 soft key: Selects uppercase alphabet (A), lowercase alphabet (a), or value

(1).

The character type that you can enter changes each time you
press the A/a/1 soft key.  The selected character type is
displayed at the bottom section of the character/number input

window.

Basic Operation
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Changing the Date/Time
In this example, we will change the date from the 1st to the 6th.  After carrying out this

step, reset the time to the correct date/time.

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.

Select Date/Time

3. Press DISP/ENTER once to open the Time set window.

4. Change the date from 01 to 06.
Select the input position: Press the right arrow soft key five times.  Move the

cursor in the text box.

Select the value: Press the right arrow key six times.  The cursor on
the keypad moves to 6.

Enter the value: Press DISP/ENTER once to enter 6.

Move to enter the input: Press the down arrow key once.  The cursor on the
keypad moves to ENT.

Enter the input: Press DISP/ENTER once.

Cancel the setting: Press ESC before pressing DISP/ENTER (entering
the input).

Display the Time set window
(Display after entering 6)

5. Press ESC or MENU to return to the operation mode screen.

Operation complete.

Basic Operation
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Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

Type T 
thermocouple Channel 2

DX

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.

3. Press the down arrow key once to select Meas channel.
4. Press the right arrow key once.

Select the Range, Alarm

5. Press DISP/ENTER once.

Select First-CH

6. Press the 2 soft key once.  The Last-CH is also set to 2.

7. Press the down arrow key once to move the cursor to Mode.

Basic Operation
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8. Press the TC soft key once.  The cursor moves to Range, and the changed item
is displayed in yellow.

Select TC

9. Press the Next soft key.

10. Press the T soft key once.  The cursor moves to Span_L.
11. Press the Input soft key once.

Display the Span_L setting window

12. Enter 0.0 in the Span Lower box.

Select the digit: Press the right arrow soft key once.  Move the
cursor in the text box.

Select the character: Press the down arrow key once.  Press the right arrow
key once.  The cursor on the keypad moves to Space.

Enter characters: Press DISP/ENTER three times.
Move to enter the input: Press the down arrow key once.  The cursor on the

keypad moves to ENT.
Enter the input: Press DISP/ENTER once.  Span_L is set, and the

cursor moves to Span_U.

Cancel the setting: Press ESC before pressing DISP/ENTER (entering
the input).

13. Press DISP/ENTER once.  The cursor moves to Span_U.

14. Enter 400.0 in the Span Upper box.
See step 12 for the procedure.

15. Press DISP/ENTER once.  The changed items are entered, and the cursor

returns to First-CH.  The changed items change from yellow to white.

16. Press ESC or MENU to return to the operation mode screen.

Operation complete.

Basic Operation
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Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval.  Here, the scan interval on the DX1012

is changed to 2 s.  The selectable scan intervals are different on the model, but the
procedure is the same.

Type T 
thermocouple Channel 2

Measures every 2 s
DX

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.

3. Hold down FUNC for at least 3 s.

Display the Basic Setting Mode menu

4. Press the down arrow key once to select A/D, Memory.
5. Press DISP/ENTER once.

Basic Operation
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6. Press the down arrow key once to move the cursor to Scan interval.
7. Press the 2s soft key once.  The cursor moves to A/D integrate, and the

changed item is displayed in yellow.
Cancel the setting:  Press ESC before pressing DISP/ENTER.

8. Press DISP/ENTER once.  The changed items are entered, and the cursor

returns to Scan mode.

Set the scan interval to 2 s

9. Press ESC once to return to the basic setting mode menu.
10. Press the up arrow key twice to move the cursor to End.
11. Press DISP/ENTER once.

Display the confirmation window

12. Press DISP/ENTER once.  The settings are saved, and the DX returns to the
operation mode screen.
Discard the changes: Select No and press DISP/ENTER.

Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.

Basic Operation
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Inserting/Removing a CF Card

Inserting a CF Card
1. Open the operation cover.

CF card
With the label “This side up” 
facing up

T
h
is sid

e u
p

CAUTION

Forcing the CF card into the slot with 
the upside down may cause damage.

2. Insert the CF card into the slot.

Displays the CF card icon

3. Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>

1. Press FUNC once.

2. Press the Next soft key.

CF card icon

Media eject

3. Press the Media eject soft key once.
4. Press the CF soft key once.  The message “Media can be removed safely”

appears.  Displays the CF card icon in blue.

5. Open the operation cover.

Basic Operation
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6. Press the CF card eject button.  When you eject the CF card, the storage media
icon disappears.

Eject button

Press the eject button in until it clicks.
The eject button stops at depressed position.
Pinch the left and right sides of the CF card 
and remove it.

7. Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>
1. Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to

the basic setting mode), select Load settings, Initialize > Media eject > CF,
and press DISP/ENTER.

Select CF

The message “Media can be removed safely” appears.
2. Open the operation cover.

3. Press the CF card eject button.  Remove the CF card.
4. Close the operation cover.

Operation complete.

Note
If you remove the CF card without carrying out the media eject procedure, the message “Media

was removed compulsorily” appears.  Remove the CF card by carrying out the procedure above

to prevent damaging the data that is stored.

Basic Operation
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Saving the Setup Data
In this example, we will save the setup data to a file named “SF2” on the CF card.

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.
3. Press the up arrow key twice to select Save/Load.

4. Press the right arrow key once and down arrow key three times.

Select Save settings

5. Press DISP/ENTER once.
6. Press the Input soft key once.

7. Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 16.

8. Press DISP/ENTER once.  The message “Data are being saved to media”
appears, and the setup data is saved.

9. Press ESC or MENU to return to the operation mode screen.

Operation complete.

Basic Operation
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Loading the Setup Data
In this example, we will load the setup data “SF2” from the CF card and update the DX settings.

Here, only the setup data of the setting mode is loaded.  To load the setup data of both
the setting mode and basic setting mode, press MENU, hold down FUNC for 3 s, select
Load settings, Initialize > Load settings, and press DISP/ENTER.

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.
3. Press the up arrow key twice to select Save/Load.
4. Press the right arrow key once and down arrow key twice.

Select Load settings

5. Press DISP/ENTER once to select the root directory (CF:/).

6. Press DISP/ENTER once to display the files in the root directory.
7. Select the file SF2.PDL using the up and down arrow keys.

To move to a lower directory
Select the directory, and press 
DISP/ENTER

To move to a higher directory
Press ESC

8. Press DISP/ENTER once.  The message “File is being loaded from media”

appears, and the setup data is loaded.  The DX automatically returns to the
operation mode screen.

Operation complete.

Basic Operation
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

Type T 
thermocouple Channel 1

0.0 to 200.0°C

DX

Setup Item Description Number in the Figure

Channel Use channel 1. 1

Tag TI-001 2

Sensor Type T thermocouple 3

Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (switch to the setting mode)
From the setting menu, select: Meas Channel > Range, Alarm

1

4

3

(2) Tag
From the setting menu, select: Meas Channel > Tag, Memory, Delay

2

Operation complete.
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Setup Example 2: Flow Rate Measurement Channel and Alarm

DX

Flowmeter Channel 2

4 - 20 mA

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure

Channel Use channel 2. 1

Tag FI-002 2

Input signal 1-5V 3

Input range 0.0 to 500.0 L/H 4

Alarm condition Output an alarm if the measured 5
value is less than or equal to 120.0 L/H.
Output destination: Relay contact (I03)

(1) Input Range and Alarm
Press MENU (switch to the setting mode)

From the setting menu, select: Meas Channel > Range, Alarm

1

5

4

3

(2) Tag
From the setting menu, select: Meas Channel > Tag, Memory, Delay

2

Operation complete.

Setting the Input Range and Alarm
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

Channel 1

Group 1

Channel 2

Setup Item Description Number in the Figure

Group Assign channel 1 and 2 to group 1. 1

(1) Group
MENU key (switch to the setting mode) and select Group set, Trip line

1

Operation complete.
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Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

The sampling interval (the time 
corresponding to 1 dot) is 4 s when the trend 
interval is 2 min.
30 dots × 4 s = 2 min

30 dots/div

Setup Item Description Number in the Figure

Trend interval The waveform is updated at every 4 s. 1
Set the time per division to 2 minutes.

(1) Trend interval
Press MENU (switch to the setting mode) and select Display > Trend/Save interval

1

Operation complete.

Setting the Display
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save
In this example, we will continuously record and save the measured data of channel 1 and 2.
For the procedure to set the channel, see “Setting the Input Range and Alarm” on page 26.
For the procedure to set groups, see “Setting the Display” on page 28.

Automatically save to 
the CF card periodically

Channel 1 Channel 2

Setup Item Description Number in the Figure

Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1

Data to be recorded Continuously record the display data from 2
the start of the measurement.

Data storage method Automatically store every 24 hours. 3

Sampling interval 4 seconds.  Set using the trend update interval. 4
Sampling interval = (trend update interval setting)/30 dots

Data file name Add “sample” to the file name. 5
Example: 000123_sampleYYMMDD_HHMMSS0.DAD

↑ ↑
Sequential number Date/Time of the first recorded data and 0 (zero)

Save Destination Directory DATA-101 6

(1) Data to be Recorded
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode)
From the basic setting menu, select: A/D, Memory

2

(2) Method of Storing to the CF Card (Auto Save ON/OFF)
From the basic setting menu, select: Environment > Security, Media save

3
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(3) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.  The DX returns to the operation mode screen.

(4) Channels to Be Recorded
Press MENU (switch to the setting mode)
From the setting menu, select: Meas Channel > Tag, Memory, Delay

1

(5) Interval for Saving the Data to the CF Card
From the setting menu, select: Display > Trend/Save interval

4
3

(6) Data File Name
From the setting menu, select: Data save > File header, File name

5

(7) Save Destination Directory (within the CF Card)
From the setting menu, select: Data save > Save directory

6

Operation complete.

Setting the Data Storage
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Setup Example 6: Saving Measured Data at the Specified Time

Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.

DX

Every hour 0

Automatically save 
to the CF card

7 56

1211
10

8 4

2
1

9 3

All settings other than those listed below are the same as Setup Example 5.

Setup Item Description Number in the Figure

Data storage time Save the data once at hour 0 every day. 7

Data storage method Automatically save the measured data at 8
the specified time.

(1) Setting the Time
Press MENU (switch to the setting mode)

From the basic setting menu, select: Timer, Event action > Match time timer

7

(2) Specifying the Data Storage
From the basic setting menu, select: Timer, Event action > Event action

8

Operation complete.

Setting the Data Storage
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the USER Key
In this example, we will set the DX so that the displayed screen image data can be saved

to the CF card by pressing the USER key.  This function is called snapshot.  The
extension of snapshot data files is .png.

START USER FUNC ESC MENUSTOP

USER key

Setup Item Description Number in the Figure

Event action Save the screen image data of the DX 1
using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (switch to the setting mode) and select Timer, Event action > Event
action

1

Operation complete.
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Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the

Favorite key.  This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

Favorite key

Favorite key

Favorite key

Operation mode screens registered to the Favorite key 
(example when three screens are registered)

Favorite key

1. Display the screen to be registered.

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.

4. Press the Favorite regist soft key to display the registration list window.

Register the historical trend to the 
Favorite key

Customizing the Operation
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5. Press the favorite number (1 to 8) soft key.
6. Press the Regist soft key.

Show the window for entering the 
display name

7. Enter the screen name.

Select the digit: Left and right arrow soft keys
Enter characters: Arrow keys and DISP/ENTER
Delete a character: Use the arrow keys to select Del and press DISP/ENTER,

or press the Bs soft key.
Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.
Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 16.
8. Press DISP/ENTER once.
9. Repeat steps 1 to 8 to register up to eight screens.

Operation complete.

Customizing the Operation
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Operation

Starting the Memory Sample
1. Press START once.

Memory sample starts.

START USER FUNC ESC MENUSTOP

START key

Memory sample progress
DISP: Display data
EVENT: Event dataRecording data

Operation complete.

Stopping the Memory Sample
1. Press STOP once.

Display the confirmation window

2. Select Mem+Math or Memory using the left and right arrow keys.
Memory: Stops memory sample.
Mem+Math: Stops memory sample and computation (option).

On models without the computation function (option), the confirmation message
“Do you want to stop data storage?” appears.  Select Yes.

3. Press DISP/ENTER once.

Stop memory samping

Operation complete.



37IM 04L41B01-02E

Switching the Trend Display, Digital Display, and Bar Graph Display

1. Press DISP/ENTER once to show the display selection menu.

Down arrow key

Right arrow key

Left arrow key

Up arrow key

DISP/ENTER key

2. Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu.  To close the sub
menu that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

Select DIGITAL > GROUP 1

5. Press DISP/ENTER once to show the operation display of the selected group.

To close the menu without switching the display, press ESC.

Digital display

Group number

Operation complete.

Press the down arrow key when the trend, digital, or bar graph is displayed to switch

the display in the order trend, digital, bar graph, trend, and so on.  Press the up arrow
key to switch the display in reverse order.  Press the right arrow key or the left arrow
key to switch the group.

Operation
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Writing the Message “START”

Registering the Word “START” in Message Number 1

1. Press MENU (switch to the setting mode) and select Message.
2. Press the 1-10 soft key.

3. Press the Input soft key.

Show the message registration window

Select the digit: Left and right arrow soft keys
Enter characters: Arrow keys and DISP/ENTER
Delete a character: Use the arrow keys to select Del and press DISP/ENTER,

or press the Bs soft key.
Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.
Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 16.

4. Press DISP/ENTER.

5. Press ESC or MENU to return to the operation mode screen.

Operation complete.

Operation



39IM 04L41B01-02E

Writing Message Number 1 “START”
This operation can be carried out while memory sample is in progress.  The message is

displayed on the trend display.  Show the trend display first.

1. Press FUNC (display the FUNC key menu), press the Message soft key, and
press the 1-10 soft key.

Show the message registration window

1 soft key

2. Press the 1 soft key.

Shows the message 
(time, message, and message mark)
Also recorded to the internal memory

Operation complete.

Operation
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser
In this example, we will connect the PC and the DX via hub in a one-to-one relationship

and display and monitor the DX screen on a browser on the PC.

DX

PC

Ethernet
HUB

DX

Setup Item Description Number in the Figure

IP address 192.168.1.101 1

Subnet mask 255.255.255.0

Web server function Monitor from a Web browser on the PC 2
using operator page.

Access to the DX Display the Web page and do not set 3
access privileges.

PC

Setup Item Description Number in the Figure

IP address 192.168.1.100 4

Subnet mask 255.255.255.0

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode)
From the basic setting menu, select: Communication (Ethernet) > IP-address

1
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(2) Enabling the Web Server Function on the DX
From the basic setting menu, select: Communication (Ethernet) > Server

2

(3) Display the DX Screen on the PC
From the basic setting menu, select: Communication (Ethernet) > Web page

2

3

(4) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.

The DX returns to the operation mode screen.

(5) Setting the PC
Set the IP address and subnet mask on the PC.

4

Connecting to an Ethernet Network
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(6) Checking the Connection
Send the command below from the PC and check that a correct response is returned.

Send
>ping 192.168.1.101

Response example

>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
2. Enter the following URL.

http://192.168.1.101/operator.htm

3. Check that the DX screen appears.

Operation complete.

Connecting to an Ethernet Network
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Setup Example 10: Automatically Transferring the Measured Data File to an FTP Server
In this example, we will configure the DX so that the measured data is automatically

transferred to an FTP server on the network when the measured data is automatically
saved to the CF card.  To automatically transfer the measured data files and report files,
the auto saving of the measured data must be configured in advance (“Data storage

method” of Example 5).
This example assumes that the following network environment is used: DHCP enabled,
automatically obtain the DNS server information, and automatically register the DX host

name to the DNS server.  Set the parameters according to your network environment.

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal
memory

Setup Item Description Number in the Figure

Host name DAQSTATION1 1

Obtain the IP address Obtain automatically (DHCP) 2

Type of data to be transferred Acquired measured data 3

FTP server Server name abcdefg.co.jp 4

Port number 21

Login name ftpuser1

Password a1234

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode)

From the basic setting menu, select: Communication (Ethernet) > IP-address

2
Automatically obtain the DNS server information.
Automatically register the DX host name to the 
DNS server.

(2) Host Settings Address of the DX
From the basic setting menu, select: Communication (Ethernet) > Host settings

1

Connecting to an Ethernet Network
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(3) Data to Be Transferred to the FTP Server
From the basic setting menu, select: Communication (Ethernet) > FTP client > FTP
transfer file

3

(4) Connected setting FTP Server
From the basic setting menu, select: Communication (Ethernet) > FTP client > FTP
connection

4

(5) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.

The DX returns to the operation mode screen.
Operation complete.

Executing a File Transfer Test
1. Press FUNC once to display the FUNC key menu.
2. Press the FTP test soft key once.

3

3. Press the Primary soft key once.  The messages “FTP test is being executed”

and “Execution is complete” are displayed.  The test file (FTP_TEST.TXT) is
sent to the FTP server.

Operation complete.

Transferring the Data Files
When you start memory sample, the measured data file is transferred to the FTP server

when the data is saved to the CF card.

Connecting to an Ethernet Network
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD
In this example, we will display the measured data using the accompanying software

program, DAQSTANDARD.
1. Insert the CF card containing the measured data file (.DAD or .DAE extension)

into the PC that has DAQSTANDARD installed.

2. Start DAQSTANDARD.  The launcher is displayed.

Data viewer icon

3. Click the data viewer icon to start the data viewer.

4. From the File menu, choose Open.
5. In the Open dialog box, select the desired file, and click Open.

The data is displayed.

Operation complete.
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.

• Instrumentation Panel
The DX is designed to be installed in an instrumentation panel except for the desktop
type.

• Well-Ventilated Location
To prevent overheating, install the DX in a well-ventilated location.  For the panel cut
dimensions when arranging multiple DXs, see the page 48.  Follow the panel cut

dimensions providing adequate space between instruments when other instruments
are arranged on the panel.  For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, and top panels of the DX.

• Minimum Mechanical Vibrations
Choose an installation location with the minimum mechanical vibration.  Installing the
DX in a location with large mechanical vibration not only causes adverse effects on

the mechanism but also may hinder normal recording.
• Horizontal

Install the DX horizontally (However, the DX can be inclined up to 30 degrees

backwards for panel mounting).

Note
Condensation may occur if the DX is moved to another place where the ambient temperature

is higher, or if the temperature changes rapidly.  In addition, measurement errors will result

when using thermocouples.  If this happens, let the DX adjust to the new environment for at

least one hour before using it.

Do not install the DX in the following places.
• Outdoors
• In Direct Sunlight or Near Heat Sources

Install the DX in a place with small temperature fluctuations near room temperature
(23°C).  Placing the DX in direct sunlight or near heat appliances can cause adverse

effects on the internal circuitry.
• Where an Excessive Amount of Soot, Steam, Moisture, Dust, or Corrosive

Gases Are Present
Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX.  Avoid
such locations.

• Near Strong Magnetic Field Sources
Do not bring magnets or instruments that produce electromagnetic fields close to the
DX.  Operating the DX in strong magnetic fields can cause errors in the
measurements.

• Where the Viewing of the Display Is Poor
The DX uses a TFT color LCD for the display.  Therefore, viewing of the display from
an extreme angle is difficult.  Install the DX so that the user can view the display from

the front.
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Installation Procedure
Installation Procedure (Panel Mount Type)

Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.
2. Mount the DX to the panel using the mounting brackets that come with the

package as shown in the figure below.
• Use two brackets to support the top and bottom or the left and right sides of

the case (remove the seal that is covering the holes for the mounting

brackets beforehand).
• The proper torque for tightening the mounting screws is 0.7 to 0.9 N-m.
• Mount the DX to the rack according to the procedure below.

•   First, attach the two mounting brackets and temporarily fasten the
attachment screws.

•   Next, fix the DX in place by tightening the attachment screws with the

appropriate torque.  When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

CAUTION
• Tightening the screws too much can deform the case or damage the bracket.
• Be careful not to insert foreign objects or tools through the holes for the

mounting brackets in the case.

Panel Mounting Diagram

Screw temporarily Fixed

Front

Panel

Panel
Mounting 
bracketsMounting 

brackets Torque driver
(flat blade)

Attachment screw

DX case

In contact with 
each other

(The figure shows the case when the mounting brackets 
are used on the top and bottom of the case.)

Attachment 
screw

Note
To achieve sufficient dust and water proof performance, mount the DX in the middle of the panel

cut out.

Installation (Desktop Type (/H5[ ] Option)
The front (leg) stand can be pulled out.

CAUTION
On the desktop type, do not apply force to the DX when the front leg (stand) is

out.  This can break the front leg.

Installation and Wiring
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External Dimensions and Panel Cut Dimensions
Unit: mm (approx. inch)
Unless otherwise specified, tolerance is ±3% 
(however, tolerance is ±0.3 mm when below 10 mm).

Panel mount type

Desktop type (/H5[ ] Option)

14
4.

3
(5

.6
8)

14
3

(5
.6

3)
40 (1

.5
7)

15
(0

.5
9)

14
.4

(0
.5

7)
39

.3
(1

.5
5)

13
8.

8
(5

.4
6)

MAX  252.5 (99.4) (/H2 or /PM1)144.3
(5.68)

Panel cut dimensions

137
(5.39)

+2
0

137
(5.39)

(5.39)

+2
0

137
(5.39)

(6.89)

(6.89)

+2
0

175 MIN

175 MIN

L+2
0

L+2
0

L+2
0

137+2
0

2
3
4
5
6
7
8
9

10
n

282 (11.10)
426 (16.77)
570 (22.44)
714 (28.11)
858 (33.78)
1002 (39.45)
1146 (45.12)
1290 (50.79)
1434 (56.46)
(144×n)−6

Side-by-Side Mounting 
(vertically, max. 3 units)

Side-by-Side Mounting 
(horizontally)

Single-Unit 
Mounting

Units

(Dimensions after attaching 
the mounting bracket)

(Dimensions before attaching 
the mounting bracket)

13
6.

5
(5

.3
7)

+0
.4 0

13
6.

5

15
1.

5 
(5

.9
6)

14
4 

(5
.6

7)
*7

*5

7.
5

9.
4

(0
.3

7)
(5

.3
7)

(0
.3

0)

+0
.4 0

*6

*4

151.5 (5.96)
24.0
(0.94)

*2

MAX *1 (/H2 or /PM1)

*3

MAX 28.0 (1.10)
(/KB1 or /KB2)

144 (5.67) 2 to 26
(Allowable panel thickness)

DX1000
228.5 (9.0)
224.1 (8.82)
170.5 (6.71)
40.9 (1.61)
41.4 (1.63)
103.4 (4.07)
99.9 (3.93)

*1
*2
*3
*4
*5
*6
*7

DX1000N
258.5 (10.18)
254.1 (10.0)
200.5 (7.89)
30.9 (1.22)
34.9 (1.37)
103.4 (4.07)
106.3 (4.19)

Installation and Wiring
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Input Signal Wiring

WARNING
• To prevent electric shock while wiring, ensure that the power supply source is

turned OFF.

CAUTION
• If a strong tension is applied to the cable wired to the DX, the terminals of the DX

and/or the cable can be damaged.  In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

• To prevent fire, use signal wires having a temperature rating of 70°C or more.

• Do not apply a voltage exceeding the following value to the input terminals.
Otherwise, damage to the DX may result.
• Maximum input voltage: ±60 VDC

• Maximum common mode voltage: ±60 VDC (under measurement category
II conditions)

• The DX is a product of installation category II.

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.

It is recommended that crimp-on lug with insulation sleeves (designed for 4-mm
screws) be used when connecting the input/output signal wires to the terminals.
However, this does not apply clamped terminals (/H2).

Crimp-on lug with insulation sleeves (for 4 mm screws)

For clamped terminals (/H2), the following wire is recommended.
• Conductive cross-sectional area: 0.08 mm2 to 1.5 mm2 (AWG 28 to 16)
• Length of the stripped section of the wire: Approx. 7 mm
Take measures to prevent noise from entering the measurement circuit.
• Move the measurement circuit away from the power cable (power circuit) and ground circuit.
• It is desirable that the object being measured does not generate noise.  However, if

this is unavoidable, isolate the measurement circuit from the object.  Also, ground the
object being measured.

• Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

• To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

• Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Ω).

When using internal reference junction compensation on the thermocouple input,
take measures to stabilize the temperature at the input terminal.
• Always use the terminal cover.
• Do not use thick wires which may cause large heat dissipation (cross sectional area of

0.5 mm2 or less recommended).
• Make sure that the ambient temperature remains reasonably stable.  Large

temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal degradation,
affecting all connected devices.  If you need to make a parallel connection, then
• Turn the burnout detection function OFF.
• Ground the instruments to the same point.
• Do not turn ON or OFF another instrument during operation.  This can have adverse

effects on the other instruments.
• RTDs cannot be wired in parallel.

Installation and Wiring
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Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear

panel.  A label indicating the terminal arrangement is affixed to the cover.
1. Turn OFF the DX and remove the terminal cover.
2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws.  The proper torque for
tightening the screws is 0.6 N-m.

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for

clamped terminals (/H2).  Fold over the conducting section of the wire, for example, to make sure

that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

Input terminal block

+/A

/b

CH1
CH2

CH3
CH4

CH1
CH2

CH3
CH4

CH5
CH6

−/B

+/A

/b

−/B

CH1

CH2

CH5 CH3 CH1

CH6 CH4 CH2

CH3 CH1

CH4 CH2

/b
+/A
−/B

/b
+/A
−/B

/b
+/A
−/B

+/A

/b

CH1
CH2

−/B

Screw terminal

Input terminal block of 
the DX1002 and DX1002N

Input terminal block of 
the DX1004 and DX1004N

Input terminal block of 
the DX1006 and DX1006N

Input terminal block of 
the DX1012 and DX1012N

Clamp terminal

CH1
CH2

CH3
CH4

CH5
CH6

CH7
CH8

CH9CH11
CH10CH12

+/A

/b

−/B

CH5 CH3 CH1

CH6 CH4 CH2

CH9 CH7

CH10

CH11

CH12 CH8

/b
+/A
−/B

Installation and Wiring
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Wiring Screw Terminals

–

+
+

–

DC voltage input

TC inputDC voltage input/DI (ON/OFF) input

RTD input DC current input

DC current input

Shunt resistor

Example: For 4 to 20 mA input, use a 

 shunt resistor of 250 Ω ± 0.1%.

–

+

–

+

–

+

A

B

b

Lead wire resistance per wire of 

10 Ω or less. Make the resistance 

of the three wires equal.

A

b
B

Compensating leadwire

Wiring Clamped Terminals

Remove the terminal block
Hold both ends of the terminal 
block and pull straight.

Input signal wire
First, loosen the screw at the front using a 
flat-blade screwdriver.  Insert the input signal 
wire into the slit on the right side of the 
terminal block, and fasten the screw at the front.

Recommended wire size
0.08 to 1.5 mm2 (AWG 28 to 16)

Recommended 
length of stripped 
wire: 7 mm

Connect the wires

Flat-blade 
screwdriver

Connect the terminal block
Hold both ends of the terminal block, 
align with the connector on the DX 
side, and push the terminal block into 
the connector.

Note
RTD input terminals A and B are isolated on each channel.  Terminal b is shorted internally

across all channels.  However, terminal b is also isolated on each channel on models with the

/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).

Installation and Wiring
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Optional Terminal Wiring

WARNING
• To prevent electric shock while wiring, ensure that the power supply source is

turned OFF.

• If a voltage of more than 30 VAC or 60 VDC is to be applied to the output
terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals
to prevent the wires from slipping out when the screws become loose.

Furthermore, use double-insulated wires (dielectric strength of 2300 VAC or
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is
to be applied.  For all other wires, use basic insulated wires (dielectric strength

of 1390 VAC).  To prevent electric shock, attach the terminal cover after wiring
and make sure not to touch the terminals.

CAUTION
• Use the following circuit voltage for the connection to the alarm/FAIL/status

output terminal.

• When the connection is to Mains Circuits (primary AC power source circuits):
150 V or less

• When the connection is to circuits derived from Mains Circuits (secondary

circuits): 250 V or less
(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)

• To prevent fire, use signal wires having a temperature rating of 70°C or more.
• If a strong tension is applied to the cable wired to the DX, the terminals of the DX

and/or the cable can be damaged.  In order to prevent tension from being applied

directly on the terminals, fasten all wiring cables to the rear of the mounting panel.
• Do not short the transmitter power supply output terminal or apply external

voltage to it.  If you do, the DX may malfunction.

• When using the transmitter power supply output terminal, do not use current that
exceeds the maximum output current (25 mADC).  If you do, the DX may malfunction.

Note
For remote control wiring, use shielded wires to reduce noise.  Connect the shield to the

functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed for 4-mm
screws) be used when connecting wires to the optional input terminals.

Crimp-on lug with insulation sleeves (for 4 mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear
panel.  The optional terminal block is provided on the DX when an option that requires

input/output is installed such as the alarm output relay (/A[ ] option), FAIL/status output
relay (/F1 option), and remote control function (/R1 option), etc.  A terminal cover is
screwed in place on the measuring input terminal block.  A label indicating the terminal

arrangement is affixed to the cover.
1. Turn OFF the DX and remove the terminal cover.
2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws.  The proper torque for
tightening the screws is 0.6 N-m.

Installation and Wiring
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Arrangement of the Optional Terminals

Optional terminal block

C
NC

NO

FAIL output
Status output

6

87 5 2

3 C

4
1

6

54L 2 1

3 C8H 7

−
+

Pulse input terminal

Remote control input terminal

C
NC

NO

02 01

C
NC

NO

02 01

C
NC

NO

02

0304

01

C
NC

NO

02

0304

01

C
NC

NO

02

0304

0106 05

/A1

Terminal arrangement of /A1 to /A3, /R1, /F1, and /PM1 options

/A3

/A2

or or

/F1

/R1

/PM1

Terminal arrangement of /TPS2 and /TPS4 options

Installation and Wiring
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Alarm Output Terminal, FAIL Output Terminal, and Status Output Terminal (/A1, /A2,
/A3, and /F1)

C

NC

NO

Output format: Relay contact
Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)
Withstand voltage: 1600 VAC at 50/60 Hz for one minute 
 (between output terminals and the ground terminal)

Remote Control Input Terminal (/R1)

C C
1

1~ 8

2

3

4
5

6

7
8

• Transistor input (open collector) Internal circuit• Relay contact input 
 (voltage-free contact)

C

1
2

3

4
5

6

7
8

Withstand voltage: 1000 VDC for one minute between 
 input terminals and the ground terminal

Input format:
 Photocoupler isolation
 Shared common (C)
Allowable input voltage: 

5 VDC

5 VContact closed at 200 Ω
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC)
Leakage current when turned OFF:
 0.25 mA or less

Pulse Input Terminal (/PM1)

H

L

H

LH

L

H

L

H

L

H

L

H
8 7 6 678

L

Withstand voltage: 1000 VDC for one minute between 
 input terminals and the ground terminal

Input format:
 Photocoupler isolation
 Shared common (L)
Allowable input voltage: 

30 VDC

5 V
Internal circuit•Transistor input (open collector)• Relay contact input 

 (voltage-free contact)
Contact closed at 200 Ω
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC)
Leakage current when turned OFF:
 0.25 mA or less

24 VDC Transmitter Power Supply Output Terminal (/TPS2 and /TPS4)
Connect the DX to the transmitter as shown below.

–

+

+

–

Transmitter

Current
DX

Transmitter power 
supply output 
terminal

Input terminal

Shunt resistor: 250 Ω

Note
To reduce noise, use a shielded cable for wiring.  Connect the shield to the functional ground

terminal or the ground terminal of the DX.

Serial Interface
Connecting to the RS-232 Connector (/C2)
2 1 3 4 5

6 7 98

2 RD (Received Data): Received data from the PC. Input signal to the DX.
3 SD (Send Data): Transmitted data to the PC. Output signal from the DX.
5 SG (Signal Ground): Signal ground.
7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal  
     from the DX.
8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to 
     the DX.
* Pins 1, 4, 6, and 9 are not used.

Installation and Wiring
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Connecting to the RS-422A/485 (/C3)

FG (Frame Ground)  Frame ground of the DX.
SG (Signal Ground)  Signal ground.
SDB (Send Data B)  Send data B (+).
SDA (Send Data A)  Send data A (−).
RDB (Received Data B)  Receive data B (+).
RDA (Received Data A)  Receive data A (−).FG SG SDB SDA RDB RDA

Two-wire system

FG SG SDB SDA RDB RDA

Electric potential of the shield

Four-wire system

Shield

Recommended length of stripped wire: 9 mm.  Recommended tightening torque: 0.4-0.5 Nm

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the 
Modbus protocol).  The cable should meet the following specifications.
• Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),  
  2 pair 24 AWG or more (two-wire)
• Characteristic impedance: 100 Ω
• Capacitance: 50 pF/m
• Total cable length: Up to 1.2 km

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

USB port
USB port

RearFront

USB CF  CARD

Connecting to the Ethernet Port
Ethernet port

Indicator

Checking the Connection/Communication Status
The connection status of the Ethernet interface can be confirmed with the indicator that

is located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface

Illuminated (green) The Ethernet interface is electrically connected.

Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display
• Checking the Connection at the status indication section of the DX display.

You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status indication section of the basic setting
mode display.  The basic setting menu appears by pressing MENU to display the

setting menu followed by FUNC for approximately 3 s.
• Checking the Connection Status in the Display Section in the Upper Right

Corner of the COMMUNICATION LOG Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on
the display section in the upper right corner of the COMMUNICATION LOG display.

Indicator Connection Status of the Ethernet Interface

Illuminated (green) The Ethernet interface is electrically connected.

Off The Ethernet interface is not electrically connected.

Installation and Wiring
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Power Supply Wiring
Panel Mount Type

Precautions to Be Taken While Wiring the Power Supply
This section explains the precautions to be taken on models whose rated supply voltage is
100 to 240 VAC.  Make sure to follow the warnings below when wiring the power supply.
To prevent electric shock and damage to the DX, observe the following warnings.

WARNING
• To prevent electric shock when wiring, ensure the main power supply is turned OFF.
• To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20-16) or

an equivalent wire for power wiring.
• Make sure to earth ground the protective earth terminal through a grounding

resistance less than 100 Ω before turning ON the power.
• Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply

wires and protective grounding wires.
• To prevent electric shock, make sure to close the transparent cover for the

power supply wires.
• Make sure to provide a power switch (double-pole type) on the power supply

line in order to separate the DX from the main power supply.  Put an indication
on this switch as the breaker on the power supply line for the DX and indications
of ON and OFF.  Switch specifications  Steady-state current rating: 1 A or more.
Inrush current rating: 60 A or more.  Complies with IEC60947-1, 3.

• Connect a fuse (between 2 A and 15 A) to the power line.
• Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:

Item Condition

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range 90 to 132/180 to 264 VAC

Rated power supply frequency 50/60 Hz

Allowable power supply frequency range 50/60 Hz ± 2%

Maximum power consumption 45 VA (100 V)/60 VA (240 V)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on

the measurement accuracy.

Wiring Procedure
1. Turn OFF the power to the DX and open the transparent power terminal cover.
2. Wire the power cord and the protective ground cord to the power supply

terminals.  Use ring-tongue crimp-on lugs (designed for 4 mm screws).

Power cord

Functional ground terminal
Protective grounding cord

NL

AC~
60VA MAX50/60Hz

100-240V

Note
Do not wire the protective grounding 
cord to the functional ground terminal.

3. Replace the power terminal cover, and fasten it with screws.

Installation and Wiring
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Desktop Type (/H5[ ] Option)
Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply.  To prevent
electric shock and damage to the DX, observe the following warnings.

WARNING
• Before connecting the power cord, ensure that the source voltage matches the

rated supply voltage of the DX and that it is within the maximum rated voltage

range of the provided power cord.
• Connect the power cord after checking that the power switch of the DX is turned

OFF.

• To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

• Make sure to perform protective earth grounding to prevent electric shock.

Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

• Do not use an extension cord without protective earth ground.  Otherwise, the

protection function will be compromised.

Use a power supply that meets the following conditions:

Item Condition

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range 90 to 132, 180 to 264 VAC

Rated power supply frequency 50/60 Hz

Allowable power supply frequency range 50/60 Hz ± 2%

Maximum power consumption 45 VA (100V) and 60 VA (240 V)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on

the measurement accuracy.

Connection Procedure
1. Check that the power switch is OFF.

2. Connect the power cord plug to the power connector on the rear panel.  (Use
the power cord that comes with the package.)

3. Check that the power outlet meets the conditions given in the table above and

that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package.  Then, connect the other end of the power
cord to the power outlet.  The AC outlet must be of a three-prong type with a

protective earth ground.

Installation and Wiring
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Recommended Replacement Periods for Worn Parts

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts.  The

following table shows the recommended replacement period for expendable parts.  The
replacement period shown here applies when the recorder is used under standard
operating conditions.  For the actual replacement period, consider the actual conditions

of use.  Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA.  Contact your nearest YOKOGAWA dealer when
such replacement is necessary.

LCD 

Battery

Dust and water 
proof rubber 
strip

Aluminum 
electrolytic 
capacitor

5 years

10 years

5 years

5 years

5 years

5 years*

5 years*

Backlight module

Lithium battery

Rubber strip

Key case assembly

Key case assembly

Power supply assembly

AD assembly

B8703KB

B9900BR

B9967AX

B8705BM

B8705BY

−

Depends on the model

Without /KB1 or /KB2

With /KB1 or /KB2

1

1

1

1

1

1

Item

* Replacement period at the upper limit of the normal operating temperature (50°C)
 The replacement period varies depending on the operating temperature and the specifications of the DX.  
 If the operating temperature is 30°C, it may be possible to use the parts for more than 10 years.

Replacement 
period Name Part No. NotesQuantity 

Used

Note
• The LCD replacement period indicates the half life of the brightness when the brightness is set

to the factory default setting.  The half life is shortened as the brightness is set higher.  The

deterioration of brightness varies depending on the condition of use, and its determination is

subjective.  Consider these facts for determining the actual replacement period.

• The color of the LCD may become yellowish as time elapses.  The discoloration tends to

progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below.  Enter the
settings that you are using in the Setting column for your convenience.

Setting mode menu

Page 60
 Page 60 to 62
Page 63 and 64*
 Page 65
Page 65
 Page 65
Page 66
 Page 67
Page 67
 Page 67

*:  Options

Basic setting mode menu

Page 68
 Page 68
Page 68
 Page 68 and 69
Page 69*2

 Page 70*2

Page 70*1

 Page 70
Page 70
 Page 71 to 73

Page 74*1

 Page 74
Page 74

*1:  Options
*2:  Displayed when the function is enabled in the Environment settings.
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Setup Items in Setting Mode and Their Default Values

Date/Time > Date&Time

Setup Item Selectable Range or Selections Default Value Setting

Date&Time > Time set

Date/Time > Daylight Saving Time

Setup Item Selectable Range or Selections Default Value Setting

Use/Not Use/Not Not

Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ APR
OCT/NOV/DEC

Start time > Day order 1st/2nd/3rd/4th/Last 1st

Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN

Start time > Hour of the day Numerical value 2

End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ OCT
OCT/NOV/DEC

End time > Day order 1st/2nd/3rd/4th/Last Last

End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN

End time > Hour of the day Numerical value 1

Meas channel > Range, Alarm

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/DI/ Volt

1-5V/Sqrt

Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2V
Span Lower Depends on the range. –
Span Upper Depends on the range. –

Mode=TC
Range R/S/B/K/E/J/T/N/W/L/U/WRe R
Span Lower Depends on the range. –
Span Upper Depends on the range. –

Mode=RTD
Range Pt/JPt Pt
Span Lower Depends on the range. –
Span Upper Depends on the range. –

Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. –
Span Lower Depends on the range. –
Span Upper Depends on the range. –
Scale Lower –30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper –30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less

Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. –
Span Lower Depends on the range. –
Span Upper Depends on the range. –
Ref.CH Meas channel number –

Mode=DI
Range Level/Cont Level
Span Lower 0, 1 0
Span Upper 0, 1 1

Setup Items and Default Values
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Setup Item Selectable Range or Selections Default Value Setting

Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower –30000 to 30000, decimal position :0 to 4 0.00
Scale Upper –30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less –
Low-cut On/Off Off

Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. –
Span Upper Depends on the range. –
Scale Lower –30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper –30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less –
Low-cut On/Off Off
Low-cut value 0.0 to 5.0 0.5

Alarm
1, 2, 3, 4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H

r:rate L/T:delayH/t:delayL
Value Numerical value –
Relay On/Off Off
Number I01/I02/.../I06 (Depends on the model.) I01

S01/S02/S03/.../S29/S30
Detect On/Off On

Meas channel > Tag, Memory, Delay

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Tag > Characters 16 characters or less –

Memory sample > On/Off On/Off On

Alarm delay > Time 1 to 3600s 10

Meas channel > Moving average

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2

Meas channel > Color

Setup Item Selectable Range or Selections Default Value Setting

Group of channel 001-006, etc Depends on the model.

Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray
Y.green/Lightblue/Violet/Graly/Lime/Cyan/
Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/
S.green (24 colors)

Meas channel > Zone, Scale

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Zone > Lower 0 to 95 0
Zone > Upper 5 to 100 100

Scale > Position Off/1/2/3/4/5/6 1
Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Setup Items and Default Values
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Meas channel > Bar graph

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Base position Normal/Center Normal
Division 4/5/6/7/8/9/10/11/12 10

Meas channel > Partial

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

On/Off On/Off Off

Expand 1 to 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Mark kind Alarm/Fixed Alarm
Indicate on Scale On/Off Off
Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red
Alarm mark color > Alarm 2 Same as Alarm 1 Orange
Alarm mark color > Alarm 3 Same as Alarm 1 Orange
Alarm mark color > Alarm 4 Same as Alarm 1 Red

Meas channel > Color scale band

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Band area Off/In/Out Off
Color Red/Green/.../S.green (24 colors) Lime
Display position > Lower Measuring range 0.0000
Display position > Upper Measuring range 0.0100

Meas channel > Calibration correction

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Number of set points Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16 Off

1 to n > MES val Value in the measuring range/measured value –
1 to n > True val Measuring range –

Setup Items and Default Values
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Math channel > Expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

Math On/Off Off
Math > Calculation expression 120 characters or less –
Math > Span Lower –9999999 to 99999999, decimal position: 0 to 4 –
Math > Span Upper –9999999 to 99999999, decimal position: 0 to 4 –
Math > Unit 6 characters or less –

Alarm
1, 2, 3, 4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL H
Value Numerical value –
Relay On/Off Off
No. I01/I02/.../I06 (Depends on the model.) I01

S01/S02/S03/.../S29/S30
Detect On/Off On

Math channel > Constant

Setup Item Selectable Range or Selections Default Value Setting

Number of constant K01 to K60 K01

Value –9.9999E+29 to –1.0000E–30, 0, 1
1.0000E–30 to –9.9999E+29

Math channel > Tag, Memory, Delay

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

Tag > Characters 16 characters or less –

Memory sample > On/Off On/Off On

Alarm delay > Time 1 to 3600s 10

Math channel > TLOG, Rolling average

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

TLOG > Timer No. 1/2/3/4 1
TLOG > Sum scale Off, /s, /min, /h Off
TLOG > Reset On/Off Off

Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 10s

1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h

Rolling average > Number of samples 1 to 1500 1

Math channel > Color

Setup Item Selectable Range or Selections Default Value Setting

Group of channel 101-106, etc Depends on the model.

Color Red/Green/.../S.green (24 colors) Red to Gray

Math channel > Zone, Scale, Bar graph
Same as Meas channel.

Setup Items and Default Values
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Math channel > Partial

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

On/Off On/Off Off

Expand 1 to 99% 50

Boundary Span Lower+1digit to Span Upper–1digit 0.00

Math channel > Alarm mark

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

Mark kind Alarm/Fixed Alarm
Indicate on Scale On/Off Off
Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red
Alarm mark color > Alarm 2 Same as Alarm 1 Orange
Alarm mark color > Alarm 3 Same as Alarm 1 Orange
Alarm mark color > Alarm 4 Same as Alarm 1 Red

Math channel > Color scale band

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 101/102/.../124 (Depends on the model.) 101

Band area Off/In/Out Off
Color Red/Green/.../S.green (24 colors) Lime
Display position > Lower Measuring range 0.00
Display position > Upper Measuring range 1.00

Math channel > Math start action

Setup Item Selectable Range or Selections Default Value Setting

Math start Off/Start/Reset+Start Start

Setup Items and Default Values
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Display > Trend /Save interval

Setup Item Selectable Range or Selections Default Value Setting

Trend interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h (Depends on the model.)

Save interval 10min to 31day (Depends on the trend interval.) 1h
Second interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min

30min/1h/2h/4h/10h (Depends on the model.)

Display > Trend

Setup Item Selectable Range or Selections Default Value Setting

Direction Horizontal/Vertical/Wide/Split Vertical
Trend clear On/Off Off
Message direction Horizontal/Vertical Horizontal
Scale > Digit Normal/Fine Normal
Scale > Value indicator Mark/Bargraph Mark
Trend line 1/2/3 2
Grid Auto/4/5/6/7/8/9/10/11/12 Auto

Display > Bar graph

Setup Item Selectable Range or Selections Default Value Setting

Direction Horizontal/Vertical Vertical

Display > LCD

Setup Item Selectable Range or Selections Default Value Setting

Brightness 1/2/3/4/5/6/7/8 2
Backlight saver > Mode Off/Dimmer/Timeoff Off
Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
Backlight saver > Restore Key, Key+Alarm Key+Alarm

Display > Monitor

Setup Item Selectable Range or Selections Default Value Setting

Background > Display White/Black White
Background > Historical trend White/Cream/Black/Lightgray Black
Scroll time 5s/10s/20s/30s/1min 10s
Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off

Group set, Trip line

Setup Item Selectable Range or Selections Default Value Setting

Group number 1/2/3/.../9/10 1

Group set > On/Off On/Off On
Group set > Group name GROUP1 to GROUP36/16 characters or less GROUP1 etc.
Group set > CH set 39 characters or less Depends on the model.

Trip line
1, 2, 3, 4 On/Off Off
 Position 0 to 100 50
Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green

3:Blue, 4:Yellow
Line width 1/2/3 2

Message

Setup Item Selectable Range or Selections Default Value Setting

Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 1-10
61-70/71-80/81-90/91-100

1 to 100 32 characters or less –

Setup Items and Default Values
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Timer, Event action > Timer

Setup Item Selectable Range or Selections Default Value Setting

Timer No. 1/2/3/4 1

Mode Off/Relative/Absolute Off

Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On

Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h

Absolute > Ref.time 0 to 23 0:00

Timer, Event action > Match time timer

Setup Item Selectable Range or Selections Default Value Setting

Timer number 1/2/3/4 1

Kind Off/Day/Week/Month Off

Day 1 to 28 1

Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN

Hour 00:00 to 23:59 00:00

Timer action Single/Repeat Repeat

Timer, Event action > Event action

Setup Item Selectable Range or Selections Default Value Setting

Logic box number 1/2/3/.../39/40 1

Event None/Remote/Relay/Switch/Timer/ None
Matchtime/Alarm/UserKey

Remote > Remote number 1/2/3/4/5/6/7/8 1
Relay > Relay number I01/I02/.../I06 (Depends on the model.) I01
Switch > Switch No. S01/S02/S03/.../S29/S30 S01
Timer > Timer No. 1/2/3/4 1
MatchTimeTimer > Match Time Timer No. 1/2/3/4 1

Action MemoryStart/Stop/MemoryStart/MemoryStop/ DisplayGroupChange
Trigger/AlarmACK/MathStart/Stop/MathStart/
MathStop/MathReset/SaveDisplay/SaveEvent/
Message/Snapshot/DisplayRate1/2/ManualSample/
TimerReset/DisplayGroupChange/Flag/PanelLoad/
Time adjust

Message > Message No. 1 to 100 1
Message > Write to All/Select All
Message > Group number 1/2/3/.../35/36 1
Group > Group number 1/2/3/4/5/6/7/8/9/10 1
Flag > Flag number 1/2/3/4/5/6/7/8 1
TimerReset > Timer No. 1/2/3/4 1
PanelLoad> Setting file number 1/2/3 1

Setup Items and Default Values
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Data save > File header, File name

Setup Item Selectable Range or Selections Default Value Setting

File header > Characters 50 characters or less –

Data file name > Structure Date/Serial/Batch Date

Data file name > Identified strings 16 characters or less –

Data save > Save directory

Setup Item Selectable Range or Selections Default Value Setting

Directory name 32 characters or less DATA0

Data save > Event data

Setup Item Selectable Range or Selections Default Value Setting

Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/ 1s
30s/60s/120s/300s/600s (Depends on the model.)

Mode Free/Single/Repeat Free

Data length 10min to 31day (Depends on the sample rate.) 1h

Pre-trigger 0/5/25/50/75/95/100 0

Trigger signal > Key On/Off On
Trigger signal > Event-Action On/Off Off

Data save > Batch text

Setup Item Selectable Range or Selections Default Value Setting

Text field number 1/2/3/4/5/6/7/8 1

Text field > Title of field 20 characters or less –
Text field > Characters 30 characters or less –

Save/Load

Setup Item Selectable Range or Selections Default Value Setting

Load display data > Kind CF/USB CF

Load event data > Kind CF/USB CF

Load settings > Kind CF/USB CF

Save settings > Kind CF/USB CF
Save settings > File name 32 characters or less –

File list/delete > Kind CF/USB CF

Format > Kind CF/USB CF
Format > Volume name 11 characters or less –

Menu customize

Setup Item Selectable Range or Selections Default Value Setting

Function menu Select/Hide/View/Transfer –

Display menu Separate/Select/Hide/View/Transfer –

Setup Items and Default Values
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Setup Items in Basic Setting Mode and Their Default Values

Alarm

Setup Item Selectable Range or Selections Default Value Setting

Basic settings
Reflash On/Off Off
Rate of change > Decrease 1 to 32 1
Rate of change > Increase 1 to 32 1
Indicator Hold/Nonhold Nonhold

Switch, Relay
Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None
Relay > AND None/I01/I01-I02/.../I01-I06 (Depends on the option.) None
Relay > Action Energize/De_energ Energize
Relay > Hold Hold/Nonehold Nonhold

Hysteresis
Meas CH > High/Low 0.0 to 5.0 0.5
Meas CH > Delta High/Low 0.0 to 5.0 0.0
Math CH > High/Low 0.0 to 5.0 0.0

A/D, Memory

Setup Item Selectable Range or Selections Default Value Setting

Scan interval > Scan mode Normal/Fast Normal
Normal > Scan interval 125ms/250ms (DX1002, DX1002N, DX1004, DX1004N) 125ms

1s/2s/5s (DX1006, DX1006N, DX1012, DX1012N) 1s
Normal > A/D integrate Auto/50Hz/60Hz/100ms Auto
Fast > Scan interval 25ms (DX1002, DX1002N, DX1004, DX1004N) 25ms

125ms (DX1006, DX1006N, DX1012, DX1012N) 125ms
Fast > A/D integrate 600Hz 600Hz

Memory > Data kind Display/E+D/Event Display

Burnout, RJC

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH 1/2/3/.../11/12 (Depends on the model.) 1

Burnout set > Mode Off/Up/Down Off

RJC > Mode Internal/External Internal
RJC > Volt –20000 to 20000µV 0

Environment > Operating environment

Setup Item Selectable Range or Selections Default Value Setting

Tag/Channel Tag/Channel Tag

Language English/Japanese English

Remote Controller ID Off/0/1/.../30/31 Off

Temperature C/F C

Environment > View, Message, Input, Alarm

Setup Item Selectable Range or Selections Default Value Setting

View > Trend type T-Y T-Y
View > Partial On/Off Off
View > Trend rate switching On/Off Off

Message > Write group Common/Separate Common
Message > Power-fail message On/Off Off
Message > Change message On/Off Off

Input > Value on over-range Free/Over Over

Alarm > No logging On/Off Off

Setup Items and Default Values
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Environment > Security, Media save

Setup Item Selectable Range or Selections Default Value Setting

Security > Key Off/Login/Keylock Off
Security > Communication Off/Login Off

Save > Auto save On/Off On

Environment > Batch

Setup Item Selectable Range or Selections Default Value Setting

On/Off On/Off Off
Lot-No. digit Off/4/6/8 6
Auto increment On/Off On

Environment > Service port

Setup Item Selectable Range or Selections Default Value Setting

FTP 0 to 65535 21

HTTP 0 to 65535 80

SNTP 0 to 65535 123

Modbus 0 to 65535 502

Environment > Math

Setup Item Selectable Range or Selections Default Value Setting

Value on Error +Over/–Over +Over
Value on Overflow > SUM, AVE Error/Skip/Limit Skip
Value on Overflow > MAX, MIN, P-P Over/Skip Over

Environment > Report

Setup Item Selectable Range or Selections Default Value Setting

Report select > 1 Max/Min/Ave/Sum/Inst Ave
Report select > 2 Off/Max/Min/Ave/Sum/Inst Max
Report select > 3 Off/Max/Min/Ave/Sum/Inst Min
Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum
File type Separate/Combine Separate

Keylock

Setup Item Selectable Range or Selections Default Value Setting

Password 8 characters or less –

Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free

Media > External media Free/Lock Free

Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free

Setup Items and Default Values
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Login > Basic settings, Admin settings, User settings

Setup Item Selectable Range or Selections Default Value Setting

User basic settings > Auto logout Off/1min/2min/5min/10min Off
User basic settings > Operation without Login Off/Display Off

Admin settings > Admin number 1/2/3/4/5 1
Admin settings > Mode Off/Key/Comm/Web/Key+Comm Off
Admin settings > User name 20 characters or less Admin1
Admin settings > Password 8 characters or less ????????

User settings > User number 1/2/3/.../29/30 1
User settings > Mode Off/Key/Comm/Web/Key+Comm Off
User settings > User name 20 characters or less User1
User settings > Password 8 characters or less ????????
User settings > Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

Login > Authority of user

Setup Item Selectable Range or Selections Default Value Setting

Key action, Media
Authority of user 1/2/3/4/5/6/7/8/9/10 1
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free
Media > External media Free/Lock Free

Action of Function
Authority of user 1/2/3/4/5/6/7/8/9/10 1
AlarmACK Free/Lock Free
Message/Batch Free/Lock Free
Math Free/Lock Free
Data save Free/Lock Free
E-mail/FTP Free/Lock Free
Time set Free/Lock Free
Display Function Free/Lock Free

Report

Setup Item Selectable Range or Selections Default Value Setting

Basic settings > Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month Off
Basic settings > Date 1 to 28 1
Basic settings > Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Basic settings > Time (hour) 0 to 23 0:00

Report settings > Report channel number R01/R02/R03/.../R23/R24 R01
Report settings > On/Off On/Off On
Report settings > Channel Channel number 1
Report settings > Sum scale Off, /s, /min, /h, /day /s

Time settings

Setup Item Selectable Range or Selections Default Value Setting

Time zone (HHMM) –1300 to 1300 900
Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Date format Y/M/D, M/D/Y, D/M/Y, D.M.Y Y/M/D

Load settings, Initialize

Setup Item Selectable Range or Selections Default Value Setting

Load settings > Kind CF/USB CF

Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3

Media eject CF/USB –

Setup Items and Default Values
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Communication (Ethernet) > IP-address

Setup Item Selectable Range or Selections Default Value Setting

DHCP Use/Not Not

DNS accession Use/Not Use

Host-name register Use/Not Use

Fixed IP-address > IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0

Communication (Ethernet) > Host settings

Setup Item Selectable Range or Selections Default Value Setting

Host name 64 characters or less –

Domain name 64 characters or less –

Communication (Ethernet) > DNS settings

Setup Item Selectable Range or Selections Default Value Setting

Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0

Domain suffix search order > Primary 64 characters or less –
Domain suffix search order > Secondary 64 characters or less –

Communication (Ethernet) > Keep alive, Timeout

Setup Item Selectable Range or Selections Default Value Setting

Keep alive On/Off On

Application time out > On/Off On/Off Off
Application time out > Time 1 to 120 (min) 1

Communication(Ethernet) > Server

Setup Item Selectable Range or Selections Default Value Setting

FTP Use/Not Not

Web Use/Not Not

SNTP Use/Not Not

Modbus Use/Not Not

Communication (Ethernet) > Web page

Setup Item Selectable Range or Selections Default Value Setting

Page type Operator/Monitor Operator

Page type=Operator
On/Off On/Off Off
Access control Off/Admin Off
Command Use/Not Not

Page type=Monitor
On/Off On/Off Off
Access control Off/Admin/User Off

Setup Items and Default Values
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Communication (Ethernet) > E-Mail

Setup Item Selectable Range or Selections Default Value Setting

Basic settings
SMTP server name 64 characters or less –
Port number 0 to 65535 25
Recipient 1 150 characters or less –
Recipient 2 150 characters or less –
Sender 64 characters or less –

Alarm settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Active Alarms > Alarm 1 On/Off Off
Active Alarms > Alarm 2 On/Off Off
Active Alarms > Alarm 3 On/Off Off
Active Alarms > Alarm 4 On/Off Off
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Alarm_summary
Header 1 64 characters or less –
Header 2 64 characters or less –

Scheduled settings
Recipient 1 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time 00:00 to 23:59 00:00
Recipient 2 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time 00:00 to 23:59 00:00
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Periodic_data
Header 1 64 characters or less –
Header 2 64 characters or less –

System settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less System_warning
Header 1 64 characters or less –
Header 2 64 characters or less –

Report settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Report_data
Header 1 64 characters or less –
Header 2 64 characters or less –

Setup Items and Default Values
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Communication (Ethernet) > FTP client

Setup Item Selectable Range or Selections Default Value Setting

FTP transfer file
Disp&Event data On/Off Off
Report On/Off Off
Snapshot On/Off Off

FTP connection Primary/Secondary Primary
Server name 64 characters or less –
Port number 0 to 65535 21
Login name 32 characters or less –
Password 32 characters or less –
Account 32 characters or less –
PASV mode On/Off Off
Initial path 64 characters or less –

Communication (Ethernet) > SNTP client

Setup Item Selectable Range or Selections Default Value Setting

Use/Not Use/Not Not
Server name 64 characters or less –
Port number 0 to 65535 123
Access interval Off/1h/8h/12h/24h 8h
Access reference time 00:00 to 23:59 00:00
Access timeout 10s/30s/90s 30s
Time adjust on Start action On/Off Off

Communication (Ethernet) > Modbus client

Setup Item Selectable Range or Selections Default Value Setting

Basic settings
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Retry interval Off/1min/2min/5min/10min/20min/30min/1h 2min

Modbus server settings
Server number 1-8/9-16 1-8
Port 0 to 65535 502
Modbus server name 64 characters or less –
Unit Auto/Fixed Auto

Command settings
Client command number 1-8/9-16 1-8
1 to 16 Off/R/R-M/W/W-M Off
First Depends on the command type. –
Last Depends on the command type. –
Server 1/2/3/.../15/16 1
Regi. Numerical value 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L

Setup Items and Default Values
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Communication (Serial)

Setup Item Selectable Range or Selections Default Value Setting

Basic settings
Baud rate 1200/2400/4800/9600/19200/38400 9600
Data length 7/8 8
Parity Odd/Even/None Even
Handshaking Off:Off/XON:XON/XON:RS/CS:RS Off:Off
Address 1 to 99 1
Protocol Normal/Modbus/Modbus-M Normal

Modbus master > Basic settings
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Retrials Off/1/2/3/4/5/10/20 1
Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off
Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Modbus master > Command settings
Master command number 1-8/9-16 1-8
1 to 16 Off/R/R-M/W/W-M Off
First Depends on the command type. –
Last Depends on the command type. –
Addr. 1 to 247 1
Regi. Numerical value 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L

Status relay

Setup Item Selectable Range or Selections Default Value Setting

Memory/Media status On/Off Off

Measurement error On/Off Off

Communication error On/Off Off

Memory stop On/Off Off

End

Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and Yes/No/Cancel –
make the new settings take effect?

Setup Items and dDefault Values
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